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Legal 
This application is supplied AS IS with 
no warranty, express or implied. 

It is not applicable for use in life 
monitoring situations. 

It is not guaranteed to work for your 
intended purposes. 

 

Copyright 
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Andrew Haines.  All rights reserved. 

 
 
 

 



Chapter 

1 
I N T R O D U C T I O N  

Introduction 
Capability is everything.. 

he EDI Mailer module included with OPSCON’s MoveItNow Suite does a 
good job but it is limited in focus.  It only does outbound email. 

The purpose of the EDI Messenger module is to replace the EDI Mailer 
with something much more capable. 

T 
The capabilities being brought out with this module are: 

• Outbound Email 
• Outbound Popups 
• Outbound FTP 
• Outbound FTPS 
• Outbound SFTP 
• Outbound EDI-INT AS1 
• Outbound EDI-INT AS2 
• Outbound Web Services 
• Outbound Files 
• Inbound EDI-INT AS1 
• Inbound EDI-INT AS2 
 

The EDI Mailer only does the first one so you can see the improvements. 
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Chapter 

2 
U S A G E  

Usage 
Using this module is very easy. 

The module starts up at the 
current status for all queues. 

To start the processing, click on 
Queue Processing Configuration. 
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Check the queues you wish to 
have the system process and 
click the Start button. 

The system will launch the 
processing functions 
immediately, switching you to 
the status screen so you can 
watch while it processes any 
available messages. 

The system has a timer that is 
set for five minutes.  This timer 
will wake up the processing 
cycle so you can walk away 
after starting the system. 
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From the View menu you can get to the various message queues, 
view the known certificates, and enable the debugging mode. 

 

 

 

 

 

The message queues screen will allow you to edit the current entries as well. 
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The certificates view will allow you to list all the known certificates in the system.  You can not modify 
these certificates. 
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The debugging mode changes the main screen to allow access to the debug log. 

 

Just check the Debug checkbox and the next time the queues are processed you will have some detailed 
information in the text box. 
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Also available via the Help menu is the About box. 

 

 

And when closing the application you will be prompted to confirm your decision to exit.  As the 
processing cycle needs to have the application running, a confirmation is required to close everything. 
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Chapter 

3 
C O N F I G U R A T I O N  

Configuration 
The configuration of the system is fairly straight forward.  You can have your settings saved to the 
registry for future use or just for the current session. 

 

Database Configuration 
consists of the server, path to 
the database, user id, and 
password. 

 

The Certificates File is for 
importing any root certificates 
used for the Public Key 
verification. 

 

9 



 

 

The HTTP Configuration is 
used to set up the receiving of 
messages via a web site. 

It will also be used to set up any 
proxy server settings for the 
outbound messages that are 
sent via a web site. 
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The Email Configuration is used 
for both Inbound and Outbound 
messages that use SMTP. 

For Outbound messages you 
need to set up the Server, Port, 
User ID, Password, and Email 
address to use. 

The Temporary Files folder is 
where you want to store the 
attachments that may be created 
in the message process. 

The Private Key File is your PKI 
certificate that can be used for 
digitally signing messages. 

For receiving EDI-INT AS1 
messages you need to set up the 
receiving mailbox.  This 
configuration is very much like 
your home configuration. 
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Chapter 

4 
Q U E U E S  

Queues 
The message queues supported by this module are each running in a thread.  This allows the system to 
make good use of multiple processors.  It also allows for simultaneous processing of each queue. 

 

Email 
The email queue just sends the text message via email.  This is useful where basic notifications are 
needed and integration is not an issue. 

Headers: 
TO: 
CC: 
BCC: 
FROMADDRESS: 
FROMNAME: 
SUBJECT: 
REPLYTO: 
RECEIPTTO: 
CONTENT-TYPE: 
CONTENT_TRANSFER_ENCODING: 
CONTENT-DISPOSITION: 
REFERENCES: 
ORGANIZATION: 
ENCODING: 
PRIORITY: 
SIGNED: 
ENCRYPTED: 
SECURITY: 
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Filer 
The filer queue just saves the message body to a file.  This is useful when you need to integrate with 
some other system but are not able to do so automatically. 

Headers: 
FILE: 
EDITYPE: 
SEPARATOR-SEGMENT: 
SEPARATOR-ELEMENT: 
SEPARATOR-SUBELEMENT: 
 

FTP / FTPS / SFTP 
These queues are all variations on the FTP protocol.  FTPS is FTP over SSL and SFTP is FTP over 
SSH.  The FTPS and SFTP use secured connections to transmit the files where basic FTP does not.  
These queues upload the message body to the remote server.  In some cases, a trigger file is also sent. 

Headers: 
USERID 
PASSWORD 
SERVER 
PORT 
FILENAME 
REMOTEPATH 
EDITYPE: 
SEPARATOR-SEGMENT: 
SEPARATOR-ELEMENT: 
SEPARATOR-SUBELEMENT: 
CERTIFICATEFILE: 
TRIGGERFILE: 
 

Popup 
This queue takes advantage of the Windows Messenger Service on the local network desktops.  It will 
display a popup notification window that the user has to click OK on.  It only works on your local 
network so it is of limited use. 

Headers: 
TO: 
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EDI-INT AS1 
This queue is meant for handling EDI data sent via Email.  It saves the cost of the EDI VAN that is 
very common with traditional EDI configurations.  It does however require configuration between the 
partners.  Digital Signatures and Encryption are included in this standard but are optional.  The current 
release of the EDI Messenger does not support signing or encryption.  There is presently only one 
decoder for receiving messages and it does a 204 release 4030 transaction.  The sending queue works 
for any message but also does not support signing or encryption. 

Headers: 
TO: 
SUBJECT: 
CONTENT_TRANSFER_ENCODING: 
SIGNED: 
ENCRYPTED: 
SECURITY: 
EDITYPE: 
SEPARATOR-SEGMENT: 
SEPARATOR-ELEMENT: 
SEPARATOR-SUBELEMENT: 
 

EDI-INT AS2 
This queue is meant for handling EDI data sent via a web server.  It saves the cost of the EDI VAN 
that is very common with traditional EDI configurations.  It does however require configuration 
between the partners.   

Headers: 
SUBJECT: 
CONTENT_TRANSFER_ENCODING: 
SIGNED: 
ENCRYPTED: 
SECURITY: 
EDITYPE: 
SEPARATOR-SEGMENT: 
SEPARATOR-ELEMENT: 
SEPARATOR-SUBELEMENT: 
AS2-VERSION 
AS2-TO 
AS2-FROM 
MESSAGE-ID 
URI 
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Chapter 

5 
C U S T O M E R  E V E N T S  

Customer Events 
From within the Edi Messenger module you can get access to the events that have been assigned to the 
customer accounts (see the Customer Master screen in Dispatch).  This screen is much easier than the 
one found in the main system. 

 

Both grids have a context menu (a.k.a. Right Click menu). 

ISA13 is the transaction counter field and must be 1 or higher if using X.12 messages. 

X.12 Element Separator, X.12 Segment Separator, and ISA16 are the decimal numbers that represent 
the characters used to separate the Elements, Segments, and Sub-Elements respectively.  They need to 
be defined if you are using X.12 messages and do not want to use the system defaults (tilde for the 
element separator, caret for the sub-element separator, and a newline for the segment separator).  You 
can choose a character from the popup menu. 
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Use the “Set to <NULL>” menu item to clear the field. 

 

Select a character and click OK to return to 
the previous screen. 

Each character is on one line.  The four 
columns are: the decimal number, the hex 
number, the name, and the control key used 
to represent the desired character. 
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The bottom grid shows the list of events that have been subscribed to for this account. 

You can add, update, or delete entries here. 

Use the context menu to get a listing of events or to select a message 
template. 

 

 

 

 

ISA08 and GS03 are identifiers that are required for X.12 messages. 
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Chapter 

6 
M E S S A G E  T E M P L A T E S  

Message Templates 
You can edit the message templates here as well as though the main system. 

 

There is additional functionality in this screen when compared to the main system.  Here you can 
choose the message queue/type and insert various headers from a drop down list.  Future revisions will 
include database fields as well. 
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From the New button on the toolbar you can get access to the various 
supported queues/message types.  These options will create a new message with 
all the relevant message headers.  All you have to do is fill in the blanks then 
provide the message body. 

 

 

 

 

 

Also on the toolbar is a drop down field that contains all the 
known message headers grouped into sections for each message 
type.  Select the desired entry and click the Insert button.  You can 
also select the text and copy & paste it. 

 

Refer to the Queues chapter for a list of the headers that apply to each message type/queue. 
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Chapter 

7 
R E G I S T R Y  

Registry 
The system will automatically load the settings from the registry upon start up.  Default entries will be 
supplied the first time.  You can save your settings via the File menu’s Save Settings option. 

The registry key is:  HKEY_CURRENT_USER\Software\OPSCON\EDIMessenger 

 

Value Type Description 
Certificates REG_SZ Path to the certificates file. 

HTTP_EDIINTAS2HTTP_Port REG_DWORD Port to use for receiving EDI-INT AS2 
connections via HTTP. 

HTTP_EDIINTAS2HTTPS_Port REG_DWORD Port to use for receiving EDI-INT AS2 
connections via HTTPS. 

HTTP_EnableEDIINTAS2HTTP REG_DWORD Enable receiving of EDI-INT AS2 
messages via HTTP. 

HTTP_EnableEDIINTAS2HTTPS REG_DWORD Enable receiving of EDI-INT AS2 
messages via HTTPS. 

 
 

Value Type Description 
IB_Password REG_SZ Password to connect to the database. 
IB_path REG_SZ Path of the database. 
IB_server REG_SZ Database server. 
IB_username REG_SZ User ID to connect to the database. 
PrivateKeyFile REG_SZ Full path and name of the Private Key. 
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Value Type Description 

QueueEnabled_InboundEDIINTAS1 REG_DWORD Enable the inbound EDI-INT AS1 
queue 

QueueEnabled_InboundEDIINTAS2 REG_DWORD Enable the inbound EDI-INT AS2 
queue. 
Enable the outbound EDI-INT AS1 
queue. QueueEnabled_OutboundEDIINTAS1 REG_DWORD 

Enable the outbound EDI-INT AS2 
queue. QueueEnabled_OutboundEDIINTAS2 REG_DWORD 

QueueEnabled_OutboundEmail REG_DWORD Enable the outbound Email queue. 
QueueEnabled_OutboundFiler REG_DWORD Enable the outbound Filer queue. 
QueueEnabled_OutboundFTP REG_DWORD Enable the outbound FTP queue. 
QueueEnabled_OutboundFTPS REG_DWORD Enable the outbound FTPS queue. 
QueueEnabled_OutboundPopup REG_DWORD Enable the outbound Popup queue. 
QueueEnabled_OutboundSFTP REG_DWORD Enable the outbound SFTP queue. 

Enable the outbound Web Service 
queue. QueueEnabled_OutboundWebServices REG_DWORD 

QueueMinutes REG_DWORD Number of minutes between the queue 
processing cycles.  Defaults to 5. 

 
 

Value Type Description 
SMTP_Email REG_SZ Email address to use for “From” 
SMTP_Password REG_SZ Password to connect to the server. 
SMTP_Port REG_DWORD Port to connect to. 
SMTP_Server REG_SZ Server to connect to. 
SMTP_UserId REG_SZ User ID to use to connect to the server.
TempFiles REG_SZ Path of temporary files folder. 
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